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MICROSOFT EXCEL

Fiind o aplicatie din pachetul Microsoft Office, Microsoft Excel prezintd o interfatd
asemanatoare cu editorul de text Microsoft Word avand aceeasi organizare a sistemului de meniuri si
a barelor de instrumente.

Pentru a lansa in executie programul Microsoft Excel utilizati una dintre procedurile urmatoare:

1. Start->Programs—> Microsoft Excel
2. dublu click pe iconul programului (daca exista pe desktop) !

La lansarea aplicatiei se va deschide un fisier nou reprezentand un caiet cu foi de calcul
(WorkBook), alcatuit din mai multe foi de calcul (Sheet), prima dintre ele fiind cea activa.
La randul sau fiecare foaie de calcul contine linii §i coloane care formeaza de fapt, un tabel.
Intersectiile liniilor si coloanelor genereaza celule, in care utilizatorul introduce in timpul
lucrului, diferite informatii (numere, texte, formule). Fisierele create cu Microsoft Excel au
extensia .xls

Fiecare workbook contine initial trei foi de calcul care pot fi modificate pe parcursul
unei sesiuni de lucru. O foaie de calcul este formata din 256 de coloane si 65 536 de linii.
Codul atasat liniilor este 1,2,3 ......... , 1ar cel al coloanelor este A, ....... Z, AA,........ AZ, BA,
......... BZ, .......O celula se afla la intersectia unei linii cu o coloana, adresa acesteia fiind data
de litera coloanei si de numarul liniei pe care se afla (exemplu : B10, C2).

Pentru Inchiderea aplicatiei, utilizati una dintre procedurile urmatoare:

1. Alegeti File, apoi Exit.
Apasati combinatia de taste Alt + F4.

3. Efectuati clic pe butonul de inchidere = situat in coltul din dreapta sus al ecranului, pe bara
de titlu !E'E

Pentru deschiderea unui fisier .xIs existent pe hard disc, efectuati una dintre urmatoarele operatii :

1. Alegeti Open din meniul File

!

2. Executati clic pe butonul Open = de pe bara standard
3. Apasati tastele CTRL+O.

Apoi selectati directorul care contine fisierul dorit, fisierul in cauza si ulterior actionati
butonul Open.

Pentru salvarea unui document, puteti utiliza una dintre procedurile urmatoare:
1. Alegeti optiunea Save as... din meniul File
.
2. Executati clic pe butonul Save de pe bara standard

3. Apasati tastele CTRL+S
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MICROSOFT EXCEL

Pentru salvarea unui registru de foi de calcul sub alt format: .zxt, .html, etc., trebuie sa specificati noul
format in caseta Save as type din fereastra Save A

Introducerea de informatii intr-o celula

De obicei, inainte de introducerea unei valori Intr-o celuld, aceasta trebuie configurata prin
alegerea si fixarea atributului ei informational. Aceasta se face utilizdnd optiunea Format — Cells

De aici alegeti tipul de data corespunzator

Format Cells | Aici f|xgt| numarul
de zecimale
Murnber N Alignment I Fant | Border | Patterns I F'ru:-teu:tiu:unl
L
Categary: ample 7
23,00 /

Currency Decimal places: Iz 3“ Activati caseta daca

g;‘;g””“”g separatorul miilor este

Tirne [ Useg000 Separatari virgula

Percentage . :

Frackion Megative numbers:

Scientific

Texk 1234,10

Special -1234,10 4\_1\

Custom ;I -1234,10 n Formate pentru
—

numere negative

Murber is used for general display of numbers, Currency and Sccounking
offer specialized Formatting for monetary walue,

oK I Zancel

fn momentul introducerii informatiilor in celula activd, atit in celuld, cit si pe bara de
formule apare progresiv continutul introdus. La terminarea tastarii continutului apasati ENTER sau

clic pe butonul ENTER || de pe bara de formule.

O renuntare la ceea ce s-a introdus se comunica prin tasta ESC sau clic pe butonul CANCEL X de

pe bara de formule.
Pentru a introduce date de tip text intr-o celuld, executati urmatoarele operatii :

1. Activati celula in care va fi introdus textul (prin executarea unui clic asupra acesteia cu
mouse-ul).

2. Introduceti textul dorit.

3. Pentru acceptarea textului, apdsati tasta Enter sau efectuati clic pe butonul de confirmare
situat pe Bara de formule.

Este posibil ca un text sd cuprindd mai multe celule de pe aceeasi linie, insd acesta va
apartine unei singure celule, si anume, celei in care a fost introdus. Daca datele introduse au fost
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MICROSOFT EXCEL

incorecte sau se renunta la introducerea lor, atunci actionati tasta Esc butonul de abandonare din Bara
de formule.

Datele de tip Numeric se construiesc folosind caracterele: 0,1,2,..., 9, +, -, (, ), /, $, %,
virgula, punctul, E sau e. Numadrul construit cu ajutorul unor astfel de caractere, va reprezenta o
valoare numerica constanta. Caracterele $ si % indica exprimarea in dolari, respectiv in procente.

Pentru a introduce date de tip numeric formatati initial celula in cauzd pentru tipul Numeric.
Apoi executati urmatoarele operatii :

1. Executati clic asupra celulei 1n care doriti sa introduceti numarul.
2. Tastati numarul

3. Executati clic pe o alta celula sau pe butonul . din bara de formule pentru a accepta
numarul sau apasati tasta Enter)

Daca dorim renuntarea la acest numar vom executa clic pe butonul X din bara de formule
(sau vom apasa tasta Esc).

Introducerea orei §i a datei calendaristice

Data calendaristica poate fi afisata in 13 formate, iar ora in 8 formate prestabilite.

Pentru introducerea acestor date, se pot utiliza litere mari i litere mici — deoarece aceste se vor
transforma automat in formatul standard.

Pentru a introduce data calendaristica sau ora intr-o celula, executati urmatoarele operatii:

1. Selectati celula In care se va introduce ora sau data calendaristica
2. Introduceti ora sau data calendaristica dorita.

3. Executati clic pe o altd celuld sau pe butonul ~ din bara de formule ( sau apdsati tasta
Enter), pentru a fi acceptata valoarea introdusa.

Introducerea rapida a datei curente

Utilizatorul are posibilitatea de a introduce data curentd in celula doritd, prin tastarea
combinatiei de taste: Ctrl + : (doud puncte)

Introducerea rapida a orei curente

Utilizatorul are posibilitatea de a introduce ora exactd 1n celula dorita, prin tastarea
combinatiei de taste: Ctrl +Shift + : (doud puncte)

Formatarea la nivel de celula

Prin operatia de formatare atribuim unele caracteristici referitoare la aspectul exterior al unor
celule, linii sau coloane. Alinierea datelor intr-o celula poate fi stabilitd rapid cu ajutorul butoanelor
din bara de formatare astfel:

e Alinierea la dreapta
Alinierea la stinga
e Pozitionare centrata
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Pentru a alinia la stinga continutul unei celule executati urmatoarele operatii:

1. Selectati datele care se doresc aliniate
2. Actionati butonul Align Left din bara de formatare

Pentru a alinia la dreapta continutul unei celule executati urmatoarele operatii:

1. Selectati datele care se doresc aliniate
2. Actionati butonul Align Right din bara de formatare

Pentru centra continutul unei celule executati urmatoarele operatii:

1. Selectati datele care se doresc aliniate
2. Actionati butonul Center din bara de formatare

Formule de calcul si referirea celulelor

O formuld Incepe intotdeauna cu un semn egal (=) care indicd programului ca trebuie sa
efectueze o operatie matematica.

Un nume de functie (SUM, in acest caz) este o prescurtare de la o formula pe care Excel stie sa
0 execute.

Referintele de celuld aflate Intre paranteze formeaza argumentele care descriu un grup de celule
in care se afld valori; Tn general un argument furnizeazd programului datele care trebuie sa le
prelucreze.

O adresa absoluta este acea parte a referintei de celula care nu se schimba daca se copiaza sau
se mutd formula 1n foaia de calcul, 1n timp ce o adresa relativa este referinta de celula care poate fi
modificatd de program atunci cand se executa o operatie de copiere sau de mutare.

Un exemplu de adresa relativa este B8; presupunand ca este utilizata intr-o formula sau functie
care este apoi copiati intr-o alti celuld, Excel va actualiza adresa in functie de noua locatie. In unele
cazuri nu se doreste modificarea automatd a adresei in timpul copierii; pentru a ,,arata“ programului
cd nu se doreste actualizarea adresei, inainte de identificarea de coloand si/sau linie se va folosi
simbolul $. De exemplu, transformarea adresei relative B8 intr-o adresa absoluta este $B$8.
remedierea se poate face prin ,.fortarea” programului sa nu schimbe adresa numitorului, furnizand 1n
formula o adresa absolutd (B$9)

Operatori §i functii

Excel permite introducerea unor formule cu ajutorul operatorilor matematici +, —, *, /, ".
Semnul ~ este folosit pentru exponentiere, celelalte semne avand semnificatia uzuald din
matematica.
Ordinea in care se executd operatiile este urmatoarea:
+ sau — evaluarea semnului constantelor;
2. " exponentierea (ridicarea la putere sau extragerea radacinilor)

—

Reteaua educationala
Hands-on Science - Romania

Instruire prin experiment




MICROSOFT EXCEL

.,

3. *inmultire
4. /impartire
5. + adunare
6. —scadere

Daca intr-o expresie sunt doua sau mai multe operatii de acelasi tip, Excel le va executa de la
stinga la dreapta. Pentru a modifica ordinea operatiilor se poate folosi incadrarea cu paranteze.
Dacad se cunoaste numele functiei si se doreste o descriere detaliatd a ei, se poate solicita acest
lucru astfel:
1. se selecteazd Help>» Contents din bara de meniuri; va aparea o lista de subiecte;
2. se selecteaza Reference Information> Worksheet Functions;
3. se poate opta pentru listarea Tn ordine alfabeticd a functiilor (Alphabetical List of Worksheet
Functions).
In continuare vom prezenta céteva dintre functiile reprezentative:

il Paste Function Fio Q

Function category: Function name:
: |M|:ust Recentli Used | [MDETERM =]
MEDIARN
. |Financial 10
Date & Time
Makh & Trig MINA
Skatistical MINUTE 0
Lookup & Reference MIMYERSE
Database MIRE.
Texk MMULT
Logical oD
Information ;I MCDE LI

MIN{number1 number?,...)

" Returns the smallest number in a set of walues. Ignores logical values and
bexk,

1 @l (a4 I Cancel

Functia SUM
® sintaxa:
=SUM (refl, ref2, ...)
® returneaza suma argumentelor. Argumentele (refl, ref2) pot fi fie constante numerice, fie adrese
de celule.
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”ﬁ Eile Edit Wiew Insett Format Tools Data Window Help == ]
wHERYVEERY|o o [@®z A Z|We s meEk

rial -0 -Bru|E=E=Es %, e E|a
AVERAGE | ¥| X o/ =] =SUM(E1:E4)

A | B | ¢ | o | E | F | &6 [ H [ 1 [ g T K [ L —
1| 123 45 165 —
| 2 | 2 67
| 3 | 3 78
| 4 | 67 23
= =5 U (SRH=T

53

| 7|

R

El

10

11

|12

13

|14

|15 |

16

|17

| 18 |

19|

|20

| 21|

|22 |
|23

24 -
14«4 [» [pi]"Sheet1  Sheetz £ Sheet3 |« | L|J_‘
“Draw- \\I:IO.4‘|& & - A-=:.e|

Enter |,—| |_| 'Wl—l_l_

Formula poate fi generata si cu instrumentul AutoSum astfel: se selecteaza celulele in care se
afla valorile ce se doresc insumate si se apasa pe butonul X din bara de instrumente.

Functia PRODUCT
® sintaxa:
= PRODUCT (refl, ref2)
e returneazi produsul argumentelor. In mod similar functiei SUM, argumentele pot fi constante
sau adrese. Cu ajutorul ei se pot face si impartiri, prin plasarea cu argument a inversului
numarului.

Functia QUOTIENT
® sintaxa:
= QUOTIENT (refl, ref2)
¢ functia imparte numarul ref/ la numitor ref2, returnind partea Intreagd a impartirii (cétul).

Functia MOD
® sintaxa:
=MOD (refl, ref2)
¢ returneaza restul Tmpartirii lui ref! la ref2.

Functia SQRT
® sintaxa:
= SORT (refl)

® returneaza raddcina patrata a numarului ref]. Restrictia este ca refl sa fie un numar pozitiv. Un
alt mod de a obtine acelasi rezultat este = ref1” 0.5.
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Functia SMPRODUCT
® sintaxa:
= SUMPRODUCT (refl, ref2)
Fiecare argument reprezintd un tablou; un tablou este un bloc de celule adiacente avand m
coloane si n randuri (are dimensiune m X n).
Tablourile utilizate ca argumente trebuie sd aibe dimensiuni identice.
¢ Returneaza suma produselor valorilor din celulele unei coloane sau linii.
Functia COUNT
¢ Sintaxa:
= COUNT (refl, ref2)
e Functia numara intrarile corect introduse, ca si alte valori care pot fi interpretate ca numere (date
calendaristice)
Daca se doreste numdrarea tuturor datelor cu exceptia celor vide se foloseste functia COUNTA,
care are aceeasi sintaxa.

Functia MIN
® sintaxa:
= MIN (refl)

¢ Determind valoarea minima a unei serii de date.
Functia MAX are aceeasi sintaxa ca functia MIN, determinind valoarea maxima dintr-o serie de date.

Functia AVERAGE
® gintaxa:
= AVERAGE (ref)

¢ returneazd media aritmetica.

Pentru a data automat o foaie de calcul este suficient sa se introducd intr-una din celulele ei
urméitoarea formula:

=NOW ()

Functia NOW nu necesita nici un argument si se returneazd data si ora curenta de sistem. Pentru
a obtine numai data (fard marcarea timpului) se utilizeaza functia TODAY care are urmatoarea
sintaxa:

=TODAY ()

Sortarea datelor

Atunci cind datele sunt introduse intr-un tabel, nu se tine seama de ordinea in care vor fi
utilizate. Pentru a realiza sortarea datelor dintr-un tabel se vor parcurge urmatorii pasi:
® se vor selecta toate datele din tabel, cu exceptia titlului, etichetelor de coloana si a totalurilor;
se va selecta din bara de meniuri Data > Sort si va aparea caseta de dialog Sort
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e

Z Microsoft Excel - Apa
“ﬁ File Edit ‘iew Insert Format Tools | Daka Window Help Q

~u - 4l -
DEE sy s 2
Filker 3
" &rial
Form...
F7 j = Subtatals. ..
i A | B | c Validation, ..
2 Continutu! in apa al uno,  Table...
3 Text to Columns. ..
|4 | Ler_ﬂn Template Wizard...
% EaITE— Copsolidate. ..
= L i — | d Outli »
7 Castravete D e AN
i OU— PFivotTable Report. ..
9 Peste
10 \farza Get External Data  »
11 Corp omenes ! Refrest Data

Dupa identificarea cheilor de sortare se alege modul de sortare crescitoare (Ascending) sau
descrescator (Descending). Daca tabelul are etichete de coloand se va selecta My List Header Row,
in caz contrar No Header Row. Dacd se doreste schimbarea ordinii sortarii se va selecta butonul

Options.
Pentru a stabili o altd ordine de sortare decat cea implicitd se va selecta butonul Options din
caseta:
de dialog Sort.
Sort K Ed |
Sork by

" ascending
¥ Descending

Zolurin O -

Then by
I ll ' Ascending
" Descending
Then by
I LI % Ascending
" Descending
Iy lisk has

" Header row ' Mo header row

Cpkions., .. | (nls I Cancel

Optiunile din caseta de dialog Sort Options sunt urmétoarele:

First Key Order care are ca setare implicitda Normal, prin care textul este sortat de la A la Z (ordine
crescatoare) sau de la Z la A (ordine descrescétoare), dupa cum se specifica 1n caseta de dialog Sort.
Ordinea crescdtoare conform ordinii de sortare Normal se realizeaza astfel:

e dacd valorile sunt numere, atunci primele din serie vor fi valorile negative, se va continua cu
numerele pozitive;
textul va fi sortat de la A la Z fara sa se tina cont daca literele sunt mari sau mici.
Daca sunt utilizate valori logice, FALSE va apérea Tnaintea lui TRUE;
Mesajele de eroare, cum ar fi #NAME?, sunt sortate in ordinea in care apar in foaia de lucru;
Celulele vide sunt pozitionate la sfarsit, indiferent de ordinea de sortare.

Numerele introduse ca text, ca de exemplu ONE, sunt sortate Tnaintea oricarui text.
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Celelalte optiuni sunt folosite pentru sortarea datelor calendaristice (ani, luni, zile) asezate in
ordine naturala.
Case Sensitive — va face diferenta intre literele mari si cele mici, astfel incat literele mari vor fi puse
naintea literelor mici atunci cand se ordoneaza crescator.
Orientation — determina directia In care se va efectua cdutarea elementelor care trebuie sortate. Daca
sunt organizate pe coloane se va opta pentru Sort Top to Bottom; daca sunt dispuse pe linii Sort
Left to Right.

Trasarea graficelor

Pentru a realiza un grafic se parcurg urmatorii pasi:

1. Selectati datele din foaia de calcul pentru reprezentarea carora se doreste trasarea graficului; se
include coloanele sau randurile care contin valorile numerice si textul titlurilor acelor coloane sau
randuri;

2. Selectati un clic pe butonul ChartWizard ? care se gaseste in bara de instrumente standard;
indicatorul se va transforma intr-o urma fina;

3. Se va marca zona dreptunghiulara ce va contine graficul;

4. ChartWizard va prezenta diferite optiuni Intr-o serie de casete de dialog. Dupd efectuarea
alegerii, in fiecare casetd de dialog se va selecta butonul Next;

5. Dupa efectuarea alegerilor 1n ultima caseta se va selecta Finish.

57 Fle Edit View Insert Format Tools Data windaw Help ;Iilﬁ“
DEEERY sl o- & = &4z @8 8] 0| &
fria cw-Bsru EE=EH|8 %, RBEE -H-A

az | = k)

A[B[C[D[EJTF[GIH[ I [JTK[L] ™M [ N [ © | P [ @ | R
1) | 0028 05 078 1 1.2 5| 1.75] 2 —
2 015 30 45 7! 5

13

F]

g Chart Wizard - Step 1 of 4 - Chait Type

6

—7 Standard Types | Custom Types I

B Chart kype: Chart sub-type:

=N e =

[10] = b L/

il 2 TR

|12 @ Pie

13 2 ¥ (catter) \/'\._. e

14 hthy Area

15 @ Doughnut i NN IR —
16 iy Radar —

17 @) Surface

18 8s Bubble

19 i Stock -~

20 =

21 Line with markers displayed at each data

5 alue.

23

24

% Press and hald to view sample | i
14| 4 [¥ [#I] Graficul miscarii rectilinii Graficul miscarii mobil @ pm— P ”WI T | _ﬂj_‘

—

Ready

Daca se constatd ca intr-o etapd trebuia raspuns in mod diferit existd doud metode pentru a schimba
alegerea:

1. Se selecteaza butonul Back in loc de Next cand se va reveni la caseta de dialog anterioard;

2. Se apasa butonul Cancel si se reia lucrul.
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X Microsoft Excel - miscareal =(a] x|
ﬂ&le Edit Wiew Insett Format Tools Data MWindow Help =& ﬂ|

EEE R R AR
il S -|1;| I g|§
al = =| k)
BJ]C[D EJFIGIH] I JJJrK LT M [ N [ 0 [ P | @ | PR
0025 06 07 1126 15175 2

R T

E5 % 9

Chart Wizard - Step 2 of 4 - Chart Source Data - Category [X) ...

="raficul miscarii rectiin '1$A%$1:$51 E

o = = === == === —

4| |} Graficul miscarii rectilinii Graficul miscarll mabiluil/ Graficul miscar |4 | | ﬂJJ

115 | ] ] ] |

Adaugarea unei serii de date intr-un grafic se pate face prin metoda drag-and-drop, care implica

urmatoarele operatii:

1. Selectati seria de date care urmeaza a fi introduse in grafic;

2. Deplasati indicatorul de celuld pe conturul zonei selectate, astfel incit acesta sd se transforme
intr-o sageata;

3. Cand indicatorul sageata se gaseste in interiorul suprafetei graficului, eliberati butonul mouse-

ului.

™. Microsoft Excel - miscareal == =]

EF”E Edit Miew Insert Format Tools Daka Window Help _Iﬁlliﬂ
EHZEY|EBRST | o--|R®]= A 8l A¢||_§g|mo% - @

Arial ~ 10 v|BIH|§§

| =

- =| xikm)

AlB|lc|p[EJF[c[H][ 1 [JIK[L] M [ v | o [ P [ @ [ R
1 |tih) I D 025 0.5 0.75 1125 145 1.75 2 I
2 S0 S0
3
7 2] x|
& Axes I Gridlines I Legend I [Data Labels I Daka Table I
% Chart Eikle: —
z Ix(km) x{bn)
q Category (x) axis: 140
| = | 120
% [tir) . //

walue (¥ axis: a0

12 [ . e
% Second cakegary (%) axis: ;‘: //
15 | = _
16 Second walue () axis: i 2 a 4 s & T a a
1? Hm)
13
19
20 @ | Cancel < Back I Mext = I Finish I
21
22
23
24
| 25 | =
144 ¢ [ ¢4 Graficul miscarii rectiling Graficul miscarii mobiluluil £ Graficul mlscarl 1| I LI
Eeady | | T [l E—r
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Un grafic poate fi creat ca o foaie de lucru prin selectarea din bara de meniuri Insert > Chart >
As New Sheet sau prin pozitionarea cursorului mouse-ului pe eticheta foii, apdsarea pe butonul din
dreapta si selectarea Insert » Chart (se va deschide caseta de dialog Chart Wizard Step 1).

Pentru a redimensiona un grafic se va efectua un clic pe grafic; va aparea un set de patrate mici;
plasarea cursorului pe unul din aceste pétrate va avea ca efect transformarea acestuia intr-o sageata
dubla <; tindnd apdsat butonul drept al mouse-ului graficul va putea fi adus la dimensiunea dorita.

Mutarea unui grafic in interiorul foii de lucru se face prin selectarea graficului, plasarea
cursorului 1n interiorul graficului astfel incat acesta trage sageata, si eliberarea butonului cand aceasta
a ajuns 1n pozitia in care se doreste sa se mute graficul.

Daca se doreste dispunerea graficului intr-o altd foaie de calcul se va selecta graficul, iar din
bara de meniuri se va alege Edit > Cut, apoi cursorul mouse-ului va fi plasat in noua foaie de calcul
la coordonatele dorite; selectand Edit > Copy graficul va fi plasat in noua locatie.

Referent de specialitate: profesor Anca lleana, Liceul Teoretic ,,Grigore Moisil” Bucuresti

Excel este marca inregistrata a companiei Microsoft.
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